END-USER LICENSE AGREEMENT

BY ACCEPTING, YOU (ORIGINAL PURCHASER) INDICATE YOUR ACCEPTANCE OF THESE TERMS. IF YOU DO NOT WISH TO ACCEPT THE PRODUCT UNDER THESE TERMS YOU MAY CHOOSE NOT TO ACCEPT BY SELECTING "I decline..." AND NOT INSTALLING THE SOFTWARE.

The Acronis True Image (the Software) is Copyright © SWsoft, 2000–2003. All rights are reserved. The ORIGINAL PURCHASER is granted a LICENSE to use the software only, subject to the following restrictions and limitations.

1. The license is to the original purchaser only, and is not transferable without prior written Permission from SWsoft.

2. The Original Purchaser may use the Software on a single computer owned or leased by the Original Purchaser. You may not use the Software on more than a single machine even if you own or lease all of them without the written consent of SWsoft.

3. The Original Purchaser may not engage in, nor permit third parties to engage in, any of the following:
   A. Providing or permitting use of or disclosing the Software to third parties.
   B. Providing use of the Software in a computer service business, network, timesharing or multiple user arrangement to users who are not individually licensed by SWsoft.
   C. Making alterations or copies of any kind in the Software (except as specifically permitted above).
   D. Attempting to un-assemble, de-compile or reverse engineer the Software in any way.
   E. Granting sublicenses, leases, or other rights in the Software to others.
   F. Making copies, or verbal or media translations, of the users guide.
   G. Making telecommunication data transmission of the software.

SWsoft has the right to terminate this license if there is a violation of its terms or default by the Original Purchaser. Upon termination for any reason, all copies of the Software must be immediately returned to SWsoft, and the Original Purchaser shall be liable to SWsoft for any and all damages suffered as a result of the violation or default.

ENTIRE RISK

THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE IS WITH YOU THE PURCHASER. SWSOFT DOES NOT WARRANT THAT THE SOFTWARE OR ITS FUNCTIONS WILL MEET YOUR REQUIREMENTS OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR FREE OR THAT ANY DEFECTS WILL BE CORRECTED. NO LIABILITY FOR CONSEQUENTIAL DAMAGES - IN NO EVENT SHALL SWSOFT OR ITS VENDORS BE LIABLE FOR ANY DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR THE LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY OTHER PECUNIARY LOSS) ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE, EVEN IF SWSOFT HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
# Table of Contents

## CHAPTER 1. INTRODUCTION
- 1.1 What is Acronis True Image?  
- 1.2 What's new in Acronis True Image 7.0?  
- 1.3 What is a disk image?  
- 1.4 Software usage terms and conditions  

## CHAPTER 2. INSTALLATION AND OPERATION
- 2.1 Bundle contents  
- 2.2 System requirements  
- 2.3 Acronis True Image installation  
- 2.4 Running Acronis True Image  
- 2.5 Removing the program  

## CHAPTER 3. GENERAL PROGRAM INFORMATION
- 3.1 Main program window  
- 3.2 Acronis Secure Zone  
- 3.3 Acronis Startup Recovery Manager  
- 3.4 Incremental images  

## CHAPTER 4. CREATING A PARTITION (DISK) IMAGE  

## CHAPTER 5. RESTORING A DISK (PARTITION) FROM AN IMAGE  

## CHAPTER 6. BROWSING AND RESTORING INDIVIDUAL FILES
- 6.1 Connecting a virtual disk  
- 6.2 Unplugging a virtual disk  

## CHAPTER 7. TRANSFERRING THE SYSTEM TO A NEW DISK
- 7.1 General information  
- 7.2 Security  
- 7.3 Executing transfers  
- 7.4 Cloning with manual partitioning  

## CHAPTER 8. ADDING A NEW HARD DISK  

## CHAPTER 9. SCHEDULED TASKS
- 9.1 Creating scheduled tasks  
- 9.2 Managing scheduled tasks  

## CHAPTER 10. OTHER OPERATIONS
- 10.1 Checking images  
- 10.2 Creating bootable media  
- 10.3 Viewing logs  

## CHAPTER 11. TROUBLESHOOTING
- 11.1 Recovering Acronis True Image  
- 11.2 Frequently asked questions  
- 11.3 Technical support  

## APPENDIX A. PARTITIONS AND FILE SYSTEMS
- A.1 Hard disk partitions  
- A.2 File systems  
- A.2.1 FAT16  
- A.2.2 FAT32  
- A.2.3 NTFS  
- A.2.4 Linux Ext2  
- A.2.5 Linux Ext3  
- A.2.6 Linux ReiserFS
## APPENDIX B. HARD DISKS AND BIOS SETUP

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>B.1 Installing hard disks in computers</td>
<td>65</td>
</tr>
<tr>
<td>B.1.1 Installing a hard disk, general scheme</td>
<td>65</td>
</tr>
<tr>
<td>B.1.2 Motherboard sockets, IDE cable, power cable</td>
<td>66</td>
</tr>
<tr>
<td>B.1.3 Installation modes, jumpers</td>
<td>66</td>
</tr>
<tr>
<td>B.2 BIOS</td>
<td>68</td>
</tr>
<tr>
<td>B.2.1 Setup utility</td>
<td>68</td>
</tr>
<tr>
<td>B.2.2 Standard CMOS setup menu</td>
<td>68</td>
</tr>
<tr>
<td>B.2.3 Arranging boot sequence, advanced CMOS setup menu</td>
<td>70</td>
</tr>
<tr>
<td>B.2.4 AwardBIOS</td>
<td>72</td>
</tr>
<tr>
<td>B.2.5 Hard disk initialization errors</td>
<td>77</td>
</tr>
</tbody>
</table>
Chapter 1. Introduction

1.1 What is Acronis True Image?

Acronis True Image solves all backup problems, ensuring the safety of all information on your PC.

Using it, you'll be able to create exact hard disk images, including all operating systems, applications and configuration files, software updates, personal settings and all of your data.

If failures occur that block access to information or affect system operation, or if you accidentally delete necessary files, you'll be able to restore the system and lost data easily.

You won't have to select files and folders for backup, as many backup applications require. Instead, you will store all your disk data. As a result, Acronis True Image is simpler and faster than competitive applications.

You can store images on almost any PC storage device: local hard drives, network drives or a variety of IDE, SCSI, FireWire (IEEE-1394), USB (1.0, 1.1 and 2.0) and PC card (formerly called PCMCIA) removable media drives, including CD-R(W), DVD-recordable, magneto-optical, Iomega Zip and Jaz drives.

You can restore the partition or lost data from an image any time. You can also connect an image as a virtual drive, browse its contents and extract selected files to the hard disk.

The unique technology developed by Acronis and implemented in Acronis True Image allows you to create exact, sector-by-sector disk images and restore their content directly from Windows without the reboots typical for similar products.

If you are going to install a new hard disk drive, Acronis True Image will help you transfer information from the old one in minutes, including operating systems, applications, documents and personal settings.

Wizards and a user-friendly, Windows XP-styled interface will make your work even more convenient. Just answer some simple questions and let Acronis True Image take care of everything else! When a problem occurs, it will get you up and running in short order.

1.2 What's new in Acronis True Image 7.0?

Acronis True Image 7.0 has several new features:

- disk cloning
- new disk preparation
• Acronis Secure Zone
• Acronis Startup Recovery Manager
• file integrity checks
• scheduler
• incremented images support
• logs viewing
• two boot disk variants: complete and safe
• It also has an improved interface and better performance

1.3 What is a disk image?

A disk (partition) image is a file that contains a copy of all information stored on a disk. The image stores the installed operating system, all programs, and all documents and settings.

By backing up your information regularly, you will protect yourself from data loss in case of system failure or PC malfunctions.

By default, Acronis True Image image files have a “.tib” extension and can contain images of several partitions or disks.

Images of large partitions or several disks could be quite large. If so, they can be split into several files that together make an original image. A single image can also be split for burning to removable media. A single image that is split across multiple CDs is sometimes called a “spanned volume.”

Acronis True Image can create incremental images. These images that contain only those disk sectors that changed after image creation.

Acronis True Image stores only those hard disk parts that contain data (for supported partition types). This reduces image size and speeds up image creation and restoration from.

A partition image includes all files and folders independent of their attributes (including hidden and system files), boot record, FAT (file allocation table) and root.

A disk image includes images of all disk partitions as well as the zero track with master boot record (MBR).

1.4 Software usage terms and conditions

The conditions for Acronis True Image software usage are described in the «License Agreement» included with this package. The supplied registration card is the confirmation of your legal purchase and usage of Acronis True Image on your system. Each registration card has a unique registration number.

Under current legislation, the «License Agreement» is considered a contract between you and Acronis Inc. The contract is a legal document and its violation may result in legal action.

Illegal use and/or distribution of this software will be prosecuted.
Chapter 2. Installation and operation

2.1 Bundle contents

The Acronis True Image system package includes:

• an installation disk
• user manual
• License Agreement
• registration card
• advertising materials

2.2 System requirements

Acronis True Image requires the following hardware:

• Pentium or compatible PC
• 32 MB RAM
• floppy disk drive or CD-ROM drive
• VGA monitor
• mouse (recommended)
• free hard disk space for image files

A CD-ROM drive is required to install Acronis True Image

2.3 Acronis True Image installation

To install Acronis True Image:

1. Insert the installation CD into your drive.
2. Follow the instructions on the screen.
3. After making your installation choices and copying Acronis True Image files onto your hard disk, you will be prompted to create a bootable diskette or CD-R/W. (You can omit this step if you have purchased the boxed product that contains a bootable CD). While Acronis True Image creates disk images in Windows, it might be necessary to restore the image from a bootable disk. Therefore, it is strongly recommended that you create one. However, you can do that after the installation as well.

After installation of Acronis True Image is completed, you should restart your computer.
2.4 Running Acronis True Image

In normal mode, you can run Acronis True Image from Windows by selecting Acronis → True Image, from Start → Programs. This will bring the program window onto the screen.

If your operating system does not load for some reason, you can run Acronis Startup Recovery Manager. However, this must be installed prior to use; see "Acronis Startup Recovery Manager" to learn more about this procedure. To activate the program, press F11 during PC bootup, when you see a corresponding message that tells you to press that key. Acronis True Image will be run in the standalone mode, allowing you to restore previously created images or an image from the Acronis Secure Zone.

If your disk data is totally corrupted and you cannot boot (or if you have not installed Acronis Startup Recovery Manager), you should use the bootable media supplied with the retail box version or created during the installation procedure. It will automatically load Acronis True Image, allowing you to recover the damaged partitions.

2.5 Removing the program

To remove Acronis True Image from your PC, select Acronis → True Image → Remove Acronis True Image in the Programs menu. You will see a dialog to confirm the program removal. Click Yes to confirm and Acronis True Image will be completely removed. You may have to reboot your computer afterwards to complete the task.
Chapter 3. General program information

3.1 Main program window

The main program window contains the menu, toolbar and the Windows XP Explorer-like interface divided into two areas. The right area contains operation icons; the left one has corresponding action descriptions, typical actions and additional tools.

The main program window

The menu, toolbar and menu items in the left area duplicate themselves, providing more convenience.

Having selected (clicked) an operation, you can execute it in several ways: by double-clicking its icon, by selecting Start Now in the Operations menu, by selecting the same operation in the Operations window, or by clicking Start on the toolbar.

The main window contains operation icons divided into three groups.

The Disk Imaging group contains disk image operations:

- **Create Image** – create a disk (partition) image
- **Restore Image** – restore a disk (partition) from a previously created image
- **Explore Image** – connect and view an image as a virtual drive
- **Unplug Image** – disconnect the connected virtual drive
The **New Disk Deployment** group includes operations required when a new disk drive is installed:

- **Disk Clone** – transfer operating system, applications and data from the old disk to the new one
- **Add New Disk** – add a disk for data storage, leaving the operating system and applications on the old drive

The **Tasks** group initially contains only one operation:

- **Add Scheduled Task** – create a scheduled disk (partition) image creation or restoration task with specified time or periodicity.

After a scheduled task is created, its icon is added to the group. The total number of group icons depends on the number of scheduled operations.

### Program menu

The program menu line contains the **Operations**, **Tools**, **View** and **Help** items.

The **Operations** menu changes when either an operation icon or scheduled task is selected. In the first case, the menu contains only **Start Now** to execute the selected operation. For information on managing scheduled tasks, see Chapter 9.

- **Delete** – deletes selected operation. Appears only when a scheduled task is selected

The **Tools** menu contains the following items:

- **Manage Acronis Secure Zone** – creates a special hidden system partition on a disk for storing disk (partition) images
- **Activate Acronis Startup Recovery Manager** – activates the boot restoration manager
- **Check Image** – runs disk (partition) integrity checking procedure
- **Create Bootable Rescue Media** – runs the bootable media creation procedure
- **Show Log** – opens a window with logs

The **View** menu contains items for managing the program window look:

- **Toolbars** – contains commands that control toolbar icons
- **Common Task Bar** – enables/disables common task panel in the left area
- **Status Bar** – enables/disables the status bar
- **Tiles Icons List** – controls how operation icons look
- **Refresh** – refreshes the main program window

The **Help** menu allows you to invoke help and get information about Acronis True Image.
Status bar

In the bottom of the main window, there is a status bar divided into two parts. The left part briefly describes the selected operation; the right one indicates image operation progress and results.

A double-click on the operation progress line opens the operation progress window. If you double-click on the operation results, you will see the logs window (see "Viewing logs").

Taskbar notification area icon

During image creation operations, a special indicator icon appears in the notification area (the right portion of the status bar with the clock). If you place the cursor over the icon, you will see a tool tip indicating the operation’s progress. This icon doesn't depend on the main program window being open. It is present for background execution of scheduled tasks as well.

Disk and partition information

You can change disk schemes and data representation in all schemes you see in various wizards.

To the right are three icons: Arrange Icons by, Choose Details and Display the properties of the selected item (also duplicated in the context menu invoked by double-clicking objects).

To sort messages by a particular column, click the header (another click will switch the messages to the opposite order) or Arrange Icons by button and select the column.

To select columns to view, right-click the headers line or left-click the Choose Details button. Then flag the columns you want to display.

If you click the Display the properties of the selected item button, you will see the selected partition or disk properties window.

This window contains two panels. The left panel contains the properties tree and the right describes the selected property in detail. The disk information includes its physical parameters (connection type, device type, size, etc.); partition information includes both physical (sectors, location, etc.), and logical (file system, free space, assigned letter, etc.) parameters.

You can change the width of columns by dragging their borders with the mouse.

3.2 Acronis Secure Zone

Acronis Secure Zone is a special, hidden system partition for storing disk and partition images. Ordinary applications can't access it, for image security purposes.
If you create a zone, it will be listed after all PC disks available for image creation and restoration.

The Acronis Secure Zone is primarily meant to be used with Acronis Startup Recovery Manager (see below). It can be used to store both images and data.

The zone is primarily made to manually or automatically create and restore disk images safely. Therefore it is always available for image creation as long as there is space for it. If there is not enough space, older images will be deleted to create space.

This means you can automatically create disk images easily on a schedule (see Chapter 9), and you won't be bothered by zone overflow issues.

The Acronis Secure Zone can still be filled completely when creating incremental images (see "Incremental images"). This happens because the program can't delete the first (complete) image, since it might be required for restoration. Thus, you should periodically check zone free space when creating incremental images, to increase it, if necessary, or re-create base images.

We do not recommend that you create alternating incremental images. If you need to create incremental images of several disks (partitions), you should combine these operations into a single operation.

Acronis Secure Zone can be located on any local disk. It is created at the expense of unallocated space, if available, or at the expense of partition free space. A PC can have only one secure zone. To create a zone on another disk, you must first delete any existing zone.

You can store a disk (partition) image on the same disk (partition) if there's enough space for it, but you should not keep your primary images on the same partition or disk. You should burn images to removable media, such as a CD, DVD or Zip disks, another hard disk or a network drive. The only reason to create an image on the same partition (except for creating an image in the Acronis Secure Zone) is to use the image as a local, secondary backup. This backup could be used to restore damaged files. (Remember, if your disk becomes physically damaged, an image stored on the same partition will be inaccessible.)

When you click Manage Acronis Secure Zone in the menu, the program searches for the zone on all local drives. If a zone is found, the wizard will offer to delete or resize it. If there is no zone, you’ll be prompted to create it.

Before you create the zone, estimate its size. To do this, start image creation and select disks and partitions to image into the zone. At the compression level stage, you will see estimated image size. Multiply this by 1.5. If you plan to install additional applications or create incremental images, increase the zone size.

Creating Acronis Secure Zone

If there are several disks installed, select one on which to create Acronis Secure Zone.
Select the partition on which space will be used to create the zone.

Enter the size of the zone or drag the slider.

In the next window, you will see a zone creation script containing the list of briefly described operations to be performed on partitions (disks).

After you click Proceed, Acronis True Image will start creating the zone. Progress will be reflected in the opened window. If necessary, you can stop zone creation by clicking Cancel. However, the script will be canceled only after the current operation is finished.

Acronis Secure Zone creation might take several minutes or more. Please wait until the whole procedure is finished.

Resizing Acronis Secure Zone

When prompted by the wizard, select Manage Acronis Secure Zone.

Select to increase or decrease the zone. You might need to increase it to provide more space for images. The opposite situation might arise if either partition lacks free space.

After this, select a partition from which free space will be used to increase Acronis Secure Zone or that will receive free space after the zone is reduced.
Set the new size for Acronis Secure Zone.

In the next window, you will see a zone resize script containing a list of briefly described operations to be performed on partitions (disks).

After you click **Proceed**, Acronis True Image will start resizing the zone. Progress will be reflected in the opened window. If necessary, you can stop zone creation by clicking **Cancel**. However, the script will be canceled only after the current operation is finished.

Zone resizing might take several minutes or longer. Please wait until the whole procedure is finished.

**Deleting Acronis Secure Zone**

When you are prompted by the wizard, select **Remove Acronis Secure Zone**.

Select partitions to which you want to add the space freed from Acronis Secure Zone.
In the next window, you will see a zone deletion script containing a list of briefly described operations to be performed on partitions (disks).

After you click **Proceed**, Acronis True Image will start deleting the zone. Progress will be reflected in the opened window. If necessary, you can stop zone creation by clicking **Cancel**. However, the script will be canceled only after the current operation is finished.

Zone deletion might take several minutes or more. Please wait until the whole procedure is finished.

Acronis Secure Zone deletion will disable Acronis Startup Recovery Manager automatically if it is activated and destroy all images stored in the zone.

### 3.3 Acronis Startup Recovery Manager

Acronis True Image provides Acronis Startup Recovery Manager to run the program without loading the operating system. This feature is useful if Windows won't load for some reason. Using it, you can run Acronis True Image by itself to restore damaged partitions from images.

To use Acronis Startup Recovery Manager (it must be activated), turn on your PC and press F11, when you see the "Press F11 for Acronis Startup Recovery Manager" message. This will run a standalone version of Acronis True Image that only slightly differs from the complete version. For information on restoring damaged partitions, see Chapter 5.

Be careful! Disk letters in standalone Acronis True Image might sometimes differ from Windows notation.

To activate the program, click **Activate Acronis Startup Recovery Manager**.
This boot manager is required for Acronis Secure Zone to work. If the boot manager is absent, the zone creation wizard will be run (see above). The restoration manager will be installed during this procedure as well.

If there is Acronis Secure Zone on your PC, the boot manager will be activated immediately.

3.4 Incremental images

An incremental image contains only data from those hard disk sectors that changed after the previous disk image (complete or incremental) was created. Thus such an image is significantly smaller and takes less time to create than a full image. However, as it does not contain all the necessary information about disks (partitions), it requires more than one image for restoration, including the current incremental image and at least one previous image or, ideally, all the previous incremental images and the initial complete image. You can't foresee the exact number of images required for a particular restoration, as it depends on how much data changes between image creations.

Note that you can create incremental images more often, as they are far smaller than complete images and take significantly less time to create. If you create such images often, you'll be able to restore disks (partitions) relatively easily and quickly. If you just use complete images, this will require far more time and space (up to 10 times more).

An incremental image created after a disk is defragmented might be considerably larger than usual. This is because the defragmentation program changes file locations on disk and incremental images reflect these changes.

Using incremental stages instead of complete images gives you more flexibility in what you restore. It takes much less time and as little as one tenth the disk space.
Chapter 4. Creating a partition (disk) image

Disk (partition) image creation means backing up all data stored on your PC. With the image, you can restore your PC after failure and protect yourself from hard disk data losses.

Selecting partitions

In the **Select partitions for backup** window, you will see the hard disk layout of your PC. Flag a partition to select it. Flag a whole disk to select all its partitions to image. You can select one or more hard disks or any combination of partitions and hard disks.

Disk and partition layout

Having selected partitions and/or disks, click **Next**. Note that this button is disabled if no partitions or disks are selected.

Selecting image mode

On this step, you must decide if you need to create a complete or incremental partition (disk) image.
Image mode selection

A complete image contains all hard disk data, so it takes a lot of space.

An incremental image contains data only from parts that changed after the previous complete or incremental image was created, so it's usually smaller and takes less time to create.

Therefore, if you create the first disk (partition) image, you should select the complete mode.

If you already have a complete image, it is recommended that you create incremental images.

(Having a policy for creating full and incremental images is recommended. For example, you might consider creating a full image monthly and incremental images weekly.)

Selecting the previous image

If you select incremental image, you must also provide the previous one (complete or incremental) for the new image to be created. Together with the initial complete image, incremental images make the single file set that must be stored on the same device and in the same folder. If you use removable media, you can still place one image file set on several CDs or DVDs.

Previous image selection
Incremental image size are based only on changes that occurred after the previous image was created.

If all image files are stored together, it doesn’t matter which one you select, as the program will recognize them as a single image. If you stored the files on several removable disks, you must provide the latest image file; otherwise, restoration problems might occur.

Selecting image location

If you need to create a complete image, you must specify its location on a storage device:

- Acronis Secure Zone (see "Acronis Secure Zone")
- hard disk
- network disk
- removable media drive, such as CD-R/RW, DVD-R/RW, DVD+R/RW, Iomega Zip or Iomega Jaz.

Image location selection

Select the image location in the disk tree. In the File name field, enter image file name. If you select Acronis Secure Zone, you don't have to provide a name.

If there's already an image file with that name, Acronis True Image will ask if you want to overwrite it.
Selecting image file size

With this step, you can specify if the program should create a single file or split it into equal smaller images.

If you select **Automatic**, Acronis True Image will try to decide this for every case. If there's enough space on the selected disk, the program will create a single image file.

If there is not enough space, Acronis True Image will warn you and wait for your decision. You can try to free some additional space and continue or stop Acronis True Image, free some space and re-execute the procedure.

Image file size selection

FAT16 and FAT32 file systems have a 4 GB limit for maximum file sizes. FAT32 is currently the most popular end user file system. At the same time, existing hard drives have capacities of 160GB and larger! Therefore, an image file might easily exceed this limit. In that case, Acronis True Image will automatically split the image into several files.

If you need to create an image **automatically** on CD-R/RW, DVD-R/RW, DVD+R/RW media, Acronis True Image will ask you to insert a new disk when the previous one is full.

You can also fix image file size by selecting **Fixed size** and entering the desired size or selecting it from the drop-down list. By default, the value is in bytes, but you can also use kilobytes and megabytes.
You can also split the image file into several volumes when storing it on a hard drive. Later you'll be able to easily transfer these files onto CD-R/RW, DVD-R/RW, DVD+R/RW disks. Creating images directly on CD-R/RW, DVD-R/RW, DVD+R/RW might take considerably longer time then it would on a hard disk.

Selecting data compression level

Now you must select the data compression level for the image to be created.

If you select None, all data will be transferred into an image file as they are, increasing the image size. Maximum compression might reduce the program performance and prolong image creation.

Image data compression level selection

The optimal data compression level depends on disk (partition) file types and can only be understood empirically.

Usually, it is recommended that you leave the switch in the Normal position. If you need to create an image as fast as possible, select minimal compression. If you need to burn an image to removable media, you can select maximum compression.

Protecting images with passwords

An archive file with a partition (disk) image can be protected with a password. To protect an partition (disk) from being restored by anybody except you, enter a password and its confirmation into the text fields of the wizard page Image Archive Protection. A password should consist of at least eight symbols and contain both letters (in the upper and lower cases preferably) and numbers to make it more difficult to guess.
Image password protection

If you try to restore data from a password-protected image, Acronis True Image will ask for the password in a special window, allowing access only to authorized users.

Providing comments

On the Image Archive Comments wizard page, you’ll be able to provide an archive file with comments about the PC and its user, the hard disk, partition data, image creation time, and any peculiarities and conditions.

An image comment
The more details you provide in the comments, the better. If you don’t provide comments, you might mistake images and restore the wrong system partition, for example.

**Image creation script**

In the next window, you will see a disk or partition image creation script containing a list of operations to be performed.

After you click **Proceed**, Acronis True Image will start creating an image, indicating the progress in the special window. You can stop this procedure by clicking **Cancel**.

You can also close the progress window by clicking **Close**. Image creation will continue, but you will be able to start another operation or close the main program window. In the latter case, the program will continue working in the background and will automatically close once the image is ready. If you prepare some more image creation operations, they’ll be queued after the current one.

Icons of the current and queued operations will be shown in the bottom of the main program window.

If you are to burn an image to several removable media, be sure to number them, since you will have to insert them in order during the restoration.
Chapter 5. Restoring a disk (partition) from an image

As mentioned above (see "Running Acronis True Image"), Acronis True Image can be run in several ways. However, disk restoration is always performed just one way.

We recommend that you restore disks using Windows, only using other methods if Windows doesn’t load.

The boot disk (e.g. a CD) from which you loaded the program does not keep you from using other CDs with images. Acronis True Image is loaded entirely into RAM, so you can remove the bootable CD to insert an image disk.

To restore a partition from an image, Acronis True Image must obtain **exclusive access** to this partition. This means no other applications can access it at that time. If you receive a message stating that the partition can not be blocked, close applications that use this disk and start over. If you can not determine which applications use the disk, close them all.

Selecting an image to restore from

Find and select a file containing an image of the required partition. The **File Name** field will reflect its name and the **Next** will become available. If this image is located in Acronis Secure Zone, select it to choose the image on the next step.

Image selection for restoration
If you are to restore an image from removable media, e.g. CD, first insert the last CD first and then insert them in order starting from the one created first.

If you provided a comment to the image, it will help you know if you selected the right image to restore. The comment is displayed in the right part of the window. Note that the comment can be seen without entering a password for a protected image. However, the contents of such an image will still require a password.

If an image was protected with a password, Acronis True Image will ask for it. The Next button will be disabled until you enter the correct password.

If you are to restore a disk (partition) from an incremental image, you must have the current image as well as at least one, or preferably all, previous incremental images and the initial complete image. The exact number of images depends on how disk contents changed between image creation procedures.

**Selecting a partition to restore**

A single file might contain images of several partitions or even disks, as shown in the figure below.

![Select a partition to restore](image)

Select a partition to restore

During a single session, you can restore several partitions or disks, one by one, by selecting one disk and setting its parameters first and then repeating these actions for every partition or disk to be restored.

Select the necessary partition and click **Next**.
Selecting a location to restore to

As a rule, you should restore an image to the same partition from which that the image was created.

It is possible to restore an image to another partition. A partition should be at least the same size as the uncompressed image data.

![Select partition to restore image to](image)

Select partition to restore image to

All the data stored on the restored partition will be replaced by the image data, so be careful and watch for non-backed-up data that you might need.

Selecting partition type

When restoring a partition, you can change its type, though it’s not required in most cases.

To explain why you might need to do this, let’s imagine that both OS and data were stored on the same primary partition on the damaged disk. You are forced to restore the partition from a backup to another hard disk with its own partitions and OS.
Select partition type

If you need only the data, you do not have to create another primary partition. In this case, you can restore the partition as a logical partition to access the data only.

But if you are to restore a system partition, you should select the Primary type for it. Finally, if you want to load an operating system from it, select Active as well.

Selecting Active for a partition without an installed operating system could prevent your PC from booting.

Selecting a file system

Though it is seldom required to change a partition file system, you can change it during its restoration.
Select a file system

Let’s imagine you are to restore a partition from an old, low-capacity FAT16 disk to a newer disk. FAT16 would not be effective and might even be impossible to set on the high-capacity hard disk. That’s because FAT16 supports files up to 4 GB, so you won’t be able to restore a 4 GB FAT16 partition to a disk that exceeds that threshold without changing the file system.

It would make sense here to change the file system from FAT16 to FAT32 by setting the appropriate software switch.

But you must also keep in mind that not all operating systems support FAT32. MS-DOS, Windows 95 and Windows NT 3.x, 4.x do not support FAT32 and will not be operable after you restore a partition and change its file system. These can be normally restored on a FAT16 partition only.

However, you can easily convert a FAT16 partition with newer OS into FAT32.

The operating systems summary is provided in Appendix A.

Selecting restored partition size

In some cases, you might need to change the partition configuration and size during restoration. Acronis True Image is flexible enough to do this.

You can resize and relocate a partition by dragging it or its borders with a mouse or by entering corresponding values into the appropriate fields.
Select partition size and location

You might need to resize and relocate a partition in order to redistribute the disk space between existing partitions. In this case, you will have to restore the partition to be reduced first.

These changes might be useful if you are to clone a hard disk by creating its image and restoring it to a new disk with larger partitions. Such cloning is used if it is impossible to connect the second hard disk to the PC.

Assigning a letter to a partition

Windows utilizes letters to identify disks and partitions, automatically assigning them at loading.

Under Windows NT/2000/XP, Acronis True Image enables you to assign any unused letter to a restored partition (logical disk). To do this, select **Yes, I want to assign a logical drive letter to restored partition**. If you don’t set this switch, no letters will be assigned to the restored partition, hiding it from OS. Under Windows 9x/Me, this step is bypassed since letters are assigned automatically.
Assign any unused letter to a partition

You should not assign letters to partitions inaccessible to Windows, such as to those other than FAT and NTFS.

Restoring several partitions at once

You can restore several partitions during a single session. To do this, select **Yes, I want to restore another partition or hard disk drive** in the Next Selection window and click **Next**.

You can restore another partition during this operation
After this, you will see the partition selection window again and will have to repeat the actions mentioned above.

If you want to restore only one disk (partition) or have already selected all of the partitions you need, don’t set this switch and click **Next**.

**Restoration script**

In the next window, you will see a disk or partition image restoration script containing a list of operations to be performed.

![Restoration script](image)

**Restoration scenario**

After you click **Proceed**, Acronis True Image will start image restoration, indicating the progress in the special window. If you click **Cancel**, no changes will be made to disk(s).

However, it is critical to note that the partition that should have been restored from the image will be deleted and its space unallocated – the same result you will get if the restoration is unsuccessful. To recover the “lost” partition, you will have to restore it from the image again.

After the restoration is finished, you will see a message about its results.
Chapter 6. Browsing and restoring individual files

To browse and restore individual files, Acronis True Image can connect images as virtual drives, thus letting you access them as though they were a physical drive. This means that:

- A new disk with its own letter will appear in the drives list
- Using Windows Explorer and other file managers, you will be able to see image files as if they were located on a physical disk or partition
- You’ll be able to find necessary files or folders in order to copy them from the virtual disk to the real one

The connected virtual drive will be read-only and you won’t be able to change anything within it.

6.1 Connecting a virtual disk

Use Explore Image to connect an image as a virtual disk and click Next in the first wizard window.

Selecting an image

In the next window, specify the image you want to open as a virtual disk.
If the selected image file is not protected by a password, you will immediately see the image comment along with the list of stored partitions. If the file is protected by a password, you will see only the comment.

**Selecting partitions to connect and letter assignment**

You must select a partition to connect as a virtual disk. Note that you can’t connect the entire disk.

**Select partition to connect**

You can also select a letter to be assigned to the connected disk (from the Partition letter drop-down list.)

In the next window, you will see a disk-connection script containing a single operation. Click **Proceed** to connect the image as a virtual disk.

After the disk is connected, the program will run Windows Explorer showing its contents.

Now you can easily copy any file (or folder) from the virtual disk to the real one using Windows Explorer or a similar file manager.

### 6.2 Unplugging a virtual disk

We recommend that you unplug a virtual disk after all necessary files and folders are copied. However, the virtual disk will disappear after your PC is turned off.

To disconnect the virtual disk, select **Unplug**.

You can also unplug the disk by clicking **Unplug Image** in the Acronis True Image main window.
Chapter 7. Transferring the system to a new disk

7.1 General information

Sooner or later, many PC users find that their hard disk is too small. If you just don't have space for more data, you can add another disk just for data storage as described in the following chapter.

However, you might find that your hard disk does not have enough space for the operating system and installed applications, preventing you from updating your software. In this case, you have to transfer the system to a higher-capacity hard disk.

To do that, you must first install the disk in the PC. Though this operation is relatively simple, we do not recommend that inexperienced users perform it themselves; you should have a professional to do it. If you still want to do this yourself, see Appendix B.

If a PC doesn't have a bay for another hard disk, you can temporarily install it in place of your CD-ROM. If it's still impossible, you can clone a hard disk by creating its image and restoring it to a new hard disk with larger partitions.

There are two transfer modes available: automatic and manual.

In the automatic mode, you will only have to take several simple actions to transfer all the data, including partitions, folders and files, to a newer disk, making it bootable if the original disk was bootable.

There will be only one difference between these disks – partitions on the newer disk will be larger. Everything else, including the installed operating systems, data, disk labels, settings, software and everything else on the disk will remain the same.

Of course, this is the only result available in the automatic mode. The program can only duplicate the original disk layout to the new one. To obtain a different result, you will have to answer additional questions about cloning parameters.

The manual mode will provide more data transfer flexibility.

1. You will be able to select the method of partition and data transfer:
   - as is
   - new disk space is proportionally distributed between the old disk partitions
   - new disk space is distributed manually

2. You will also be able to select operations to perform on the old disk:
• leave partitions (and data!) on the old disk
• remove all information from the old disk
• Create new partitions on the old disk (and remove all the older information)

On all screenshots below, damaged partitions are marked with a red circle and a white cross inside in the upper left corner. Before you start cloning, you should check such disks for errors using corresponding operating system tools.

7.2 Security

Please note the following: if the power go out or you accidentally press **RESET** during the transfer, the procedure will be incomplete and you will have to partition and format or clone the hard disk again.

No data will be lost on the old disk though; they were only being read (no partitions were changed or resized).

Nevertheless, we do not recommend that you delete data from the old disk until you are sure it is correctly transferred to the new disk, the PC boots up from it and all applications work.

7.3 Executing transfers

**Selecting transfer mode**

You will see the **Select transfer mode** window just after the welcome window.

![Transfer mode selection](image)

**Transfer mode selection**
We recommend using automatic mode in most cases. The manual mode can be useful if you need to change the disk partition layout.

If the program finds two disks, one partitioned and another unpartitioned, it will automatically recognize the source disk as the partitioned disk and the destination disk as the unpartitioned disk, so the next two steps will be bypassed.

### Selecting source disk

If the program finds several partitioned disks, it will ask you which is the source (i.e. the older data disk).

You can determine the source and destination using the information provided in this window (disk number, capacity, label, partition and file system information).

### Selecting destination disk

After you select the source disk, you have to select the destination where the disk information will be copied.
The previously selected source becomes grayed-out and disabled for selection.

If either disk is unpartitioned, the program will automatically recognize it as destination and bypass this step.

**Partitioned destination disk**

At this point, the program checks to see if the destination disk is free. If not, you will be prompted by the **Partitioned destination disk** window stating that the destination disk contains partitions, perhaps with data.

**You can continue once existing partitions are deleted**
You will have to select between:

- **Delete partitions on the destination hard disk** – all existing partitions will be deleted during cloning and all their data will be lost.

- **No, I do not want to delete partitions** – no existing partition will be deleted, discontinuing the cloning operation. You will only be able to cancel this operation and return to select another disk.

To continue, select the first choice and click **Next**.

Note that no real changes or data destruction will be performed at this moment! For now, the program will just create a cloning script. All changes will be implemented only when you click **Proceed**, after the script is formed.

**Old and new disk partition layout**

If you selected the automatic mode before, the program will ask you for nothing further. You will see the window graphically illustrating information (as rectangles) about the source disk (partitions and unallocated space) and the destination disk layout.

Along with the disk number, some additional information is provided: Partition number, volume label (e.g. SYSTEM), file system (e.g. FAT16 or FAT32), partition size in megabytes (MB). Partition types — primary, logical — and unallocated space are marked with different colors.

Next you will see the cloning script.

**Old disk data**

If you selected the manual mode, the program will ask you what to do with the old disk:

- **Create a new partition layout** – All existing partitions and their data will be deleted (but they will also be cloned to the new disk, so you won’t lose them)

- **Keep data** – leave the old disk partitions and data intact

- **Destroy data** – delete partitions (and data!) from the old disk
If you are going to sell or give away your old disk, we recommend that you make sure you destroyed the data on it.

If you are going to keep it for data storage, you can create a new partition layout on it. In this case, the disk will be ready right after cloning is complete.

To protect yourself from unforeseen consequences, it would be better to leave the old disk data intact, as you will be able to delete it later.

**Destroying the old disk data**

If you elected to destroy the old disk data in the previous step, you will have to select the destruction method now:

- **Quick** – one-pass destruction
- **Normal** – guaranteed multipass destruction

The second method takes more time, but makes it impossible to recover data afterwards, even with special equipment.

The first method is less secure, but is still suitable for most cases.

**Selecting partition transfer method**

Acronis True Image will offer you the following data transfer methods:

- **As is**
- **Proportional** – the new disk space will be proportionally distributed between cloned partitions
- **Manual** – you will specify the new size and other parameters yourself
If you elect to transfer information "as is," a new partition will be created for every old one with the same size and type, file system and label. The unused space will become unallocated. Further, you will be able to use the unallocated space to create new partitions or to enlarge the existing partitions with special tools, such as Acronis Partition Expert.

As a rule, "as is" transfers are inexpedient, as they leave much unallocated space on the new disk.

If you transfer data proportionally, each partition will be enlarged, according to the proportion of the old and new disk capacities.

Using the "as is" method, Acronis True Image also transfers unsupported and damaged file systems.

FAT16 partitions are enlarged less than others, as they have the 4 GB size limit.

Depending on the selected combination, you will proceed to either the old disk partitioning window, or the disk partition layout window (see below).

**Partitioning the old disk**

If you selected **Create a new partition layout** earlier in the process, it is now time to repartition your old disk.

During this step, you will see the current disk partition layout. Initially, the disk has unallocated space only. This will change when you create new partitions.
Having completed the required steps, you will add a new partition. To create another one, simply repeat those steps.

If you make a mistake, click Back to redo.

After you create the necessary partitions, uncheck the Create new partition in unallocated space box and click Next.

**Old and new disk partition layouts**

In the next window, you will see rectangles indicating the source hard disk, including its partitions and unallocated space, as well as the new disk layout.

Along with the hard disk number, you will also see partition number, volume label (e.g. SYSTEM), file system (e.g. FAT16 or FAT32), partition size in megabytes (MB). Different partition types, including primary, logical and unallocated space are marked with different colors.

If you have selected manual partition creation before, the partition layout will look different. This partitioning method is described below.

**Cloning script**

In the next window, you will see the disk cloning script containing a list of briefly described operations to be performed on the partitions.
Disk partitioning script

After you click **Proceed**, Acronis True Image will start cloning the old disk to the new disk, indicating the progress in the special window. You can stop this procedure by clicking **Cancel**. In that case, you will have to repartition and format the new disk or repeat the cloning procedure.

After the operation is complete, you will see the results message.

### 7.4 Cloning with manual partitioning

#### Old and new disk partition layouts

The manual transfer method enables you to resize partitions on the new disk. By default, the program resizes them proportionally.

In the next window, you will see rectangles indicating the source hard disk, including its partitions and unallocated space, as well as the new disk layout.

Along with the hard disk number, you will see partition number, volume label (e.g. SYSTEM), file system (e.g. FAT16 or FAT32) and partition size in megabytes (Mb). Different partition types, including primary, logical and unallocated space are marked with different colors.
To resize either partition, check the **Proceed Relayout** box. If you are satisfied with the partition layout shown, uncheck this box (if checked). Clicking **Next**, you will proceed to the cloning script window.

Be careful! Clicking Back in this window will reset all size and location changes that you've selected, so you will have to specify them again.

First, select a partition to resize. It will be underlined in red.

Resize and relocate it on the next step.

You can do this by both entering values to **Unallocated space before**, **Partition size**, **Unallocated space after** fields, by dragging partition borders or the partition itself.

If the cursor turns to two vertical lines with left and right arrows, it is pointed at the partition border and you can drag it to enlarge or reduce the partition's size. If the cursor turns to four arrows, it is pointed at the partition, so you can move it to the left or right (if there's unallocated space near it).

Having provided the new location and size, click **Next**. You will be taken two steps back to the partition layout. You might have to perform some more resizing and relocation before you get the layout you need.
Chapter 8. Adding a new hard disk

If you don't have enough space for your data (e.g. family photos and videos), you can either replace the old disk with a new higher-capacity one (data transfers to new disks are described in the previous chapter), or add a new disk only to store data, leaving the system on the old disk. If the PC has space for another disk, it would be easier to add a disk drive than to clone one.

To add a new disk, you must first install it in your PC. Although this operation is relatively simple, we do not recommend it for inexperienced users, and advise them to have a professional do it. If you still want to install it yourself, first take the time to study Appendix B.

Selecting a hard disk

Select the disk that you've added to the PC.

This window might be bypassed if the program detects the new disk itself. In this case, you will immediately proceed to the New partition creation.

If there are any partitions on the new disk, they must be deleted first.

Select Delete partitions on the destination hard disk and click Next to continue.

Creating a new partition

Next you will see the current partition layout. Initially, all disk space will be unallocated. This will change after you add new partitions.
To create a partition, select **Create new partition in unallocated space** and click **Next** to perform steps required by the partition creation wizard.

If you make a mistake at partitioning, click **Back** to redo the process.

After you create the necessary partition layout, uncheck the **Create new partition in unallocated space** box and click **Next**.

**Disk add script**

In the next window, you will see the disk add script containing a list of briefly described operations to be performed on partitions (disks).

**Disk imaging script**

After you click **Proceed**, Acronis True Image will start creating and formatting new partitions, indicating the progress in the special window. You can stop this procedure by clicking **Cancel**. In that case, you will have to repartition and format the new disk or repeat the disk add procedure.

After the operation is complete, you will see the results message.
Chapter 9. Scheduled tasks

Acronis True Image allows you to schedule tasks you created, so you won't have to remember the last time you imaged your disks. It will do this for you to guarantee the safety of your data.

You can create more than one independently scheduled task.

For example, you can image your work documents daily and back up the application disk only weekly. This reduces the number of imaging operations and provides nearly the same data safety.

To create scheduled tasks, you should use the Acronis True Image scheduler.

Run the **Add New Task** wizard to create a new scheduled task. When the task is created, you will see its icon in the main window.

To edit the previously created task, click **Edit** on the toolbar or right-click the task and select **Edit**. The editing is performed in the same way as adding.

To delete a task, select it and click **Delete** on the toolbar or right-click the task and select **Delete**.

If any errors occur during the scheduled task execution, its icon will be marked with a warning sign – the red circle with a cross inside – to attract your attention the next time you run Acronis True Image. A brief error description will be shown in the left part of the window if you select the task.

9.1 Creating scheduled tasks

Selecting partitions

In the **Partition selection** window, you will see the current partition layout. To select a partition, check the corresponding box. To select all disk partitions, check the disk box. Then, all the related partitions will be checked. You can also select one or more hard disks or a random disk/partition combination.
Having selected partitions and/or disks, click **Next**. Note that this button is disabled until at least one partition or disk is selected.

Other parameters are set further in the same way as described in Chapter 4 related to image creation.

**Selecting task periodicity**

After you set image parameters, you must set task execution periodicity.

- **Daily** – a task will be executed daily at the specified time (selected on the next step)
• **Weekly** – a task will be executed weekly or in some weeks at the specified time and day (selected on the next step)

• **Monthly** – a task will be executed monthly at the specified time and day (selected on the next step)

• **One time only** – a task will be executed once at the specified time and day (selected on the next step)

• **When my computer starts** – a task will be executed at OS startup

• **When I log on** – a task will be executed, when you log into the OS

• **When my computer shuts down** – a task will be executed before every shutdown or reboot

• **When I log off** – a task will be executed when you log off of the OS

• **Never** – a task will not be executed. You can select this variant to leave it disabled

Some variants might be disabled depending on the operating system.

**Setting up daily execution**

If you select the daily execution, you will have to specify some additional parameters. First, set the **Start time** (hours and minutes).

In the **Perform this task** group, select days on which you want to execute tasks:

• **Every day**

• **Weekdays**

• **Every x days** – once in several days (specify the interval)
You can execute the task even if your PC is turned off at the specified time. To do this, select **Perform this task when the computer restarts, only if the computer was turned off at the selected time.** In this case, the task will be executed at the next startup.

**Setting up weekly execution**

If you select the weekly execution, you will have to specify some additional parameters. The first is the **Start time** (hours and minutes).

Specify periodicity in the **Every x weeks** (each week, in a week, etc.)

Check weekdays on which to execute the task.

You can execute the task even if your PC is turned off at the specified time. To do this, select **Perform this task when the computer restarts, only if the computer was turned off at the selected time.** In this case, the task will be executed at the next startup.

**Setting up monthly execution**

If you select the weekly execution, you will have to specify some additional parameters. The first is the **Start time** (hours and minutes).

In the **Perform this task** group, select time to execute tasks on:

- **Day** – on the specified date
- **The <specify a day>** – on the specified weekday (e.g. second Tuesday or fourth Friday); selected from drop-down lists
You can execute the task even if your PC is turned off at the specified time. To do this, select **Perform this task when the computer restarts, only if the computer was turned off at the selected time**. In this case, the task will be executed at the next startup.

### Setting up one-time execution

If you select the weekly execution, you will have to specify some additional parameters.

The first is the **Start time** (hours and minutes), followed by the **Start date**.
You can execute the task even if your PC is turned off at the specified time. To do this, select **Perform this task when the computer restarts, only if the computer was turned off at the selected time**. In this case, the task will be executed at the next startup.

### Entering user name

Under Windows NT/2000/XP, you will have to specify the name of the user who owns the executed task; otherwise no scheduled execution will be available.

In the upper field, enter a user name. Enter a password twice in two fields below.

Under Windows 95/98/Me, this window looks different. These operating systems require a user name and password to access networked drives only.

### Task scheduled successfully

You have finished scheduling a task. The wizard will again remind you of the details of the task provided.

To close the wizard and return to the main window, click **Finish**. The task created will be named **New task**. You can rename it appropriately.

### 9.2 Managing scheduled tasks

If you select a task in the main window, you will see its details in the left part. And the Operations menu and toolbar will be extended with **Edit**, **Schedule**, **Delete** and **Rename** icons.

**Rename** allows you to give your task a more appropriate name.
**Delete** allows to delete a selected task with confirmation.

**Edit** allows to change any task parameters. This is performed in the same way as creation with two exceptions.

First, there will be specified parameters instead of the default, so you won't have to enter them again.

Second, after you make changes, you will be asked about execution order. That is, you will be able to change image creation parameters like location without touching its execution periodicity and time (though you can change that as well.)

If you want to change only periodicity and time, select **Schedule**. Then, you will have to perform only scheduling steps, leaving image settings the same.
Chapter 10. Other operations

10.1 Checking images

To be assured that your images are not damaged, you can check their integrity. To do this, select Check Image in the Tools group (expand it if it’s not) or click Check Image on the toolbar. You will see the first wizard window. Click Next to continue.

Selecting image for checking

In this window, you will see the complete list of connected storage devices, including hard disks and other drives. Using Windows Explorer, locate the image file to be checked and select it.

Its name will appear in the File Name field and the Next button will be enabled.

Click Proceed to continue. Progress will be indicated in the new window.

You can cancel checking by clicking Cancel.

After checking is complete, you will see the results window.
10.2 Creating bootable media

In some cases, Acronis True Image can be run only from a special bootable diskette or CD. Such a case might be if your PC doesn't boot up normally.

If you've purchased the program on a CD, it will already be bootable. You can also create bootable media during or after the installation.

For this, you will need a CD-R/RW blank, five formatted diskettes (or two for the safe variant), or any other media your PC can boot from, such as a Zip drive.

Click Create Rescue Media on the toolbar or in the left part of the main window, or select Create Rescue Media from the Tools menu.

You can also create bootable media without loading Acronis True Image itself by selecting Programs → Acronis → True Image → Bootable Rescue Media Builder from the Start menu.

You will see the bootable media wizard that will ask you to select either complete or safe loader version. The latter doesn't have USB, PC card (formerly called PCMCIA) or SCSI drivers and is useful only in case the complete version doesn't work.

After you create a boot disk, identify it and keep it in a safe place.

10.3 Viewing logs

Acronis True Image allows users to view its working logs. They can provide information about scheduled image creation results, including reasons for failure, if any. Logs are created only for partition (disk) image creation operations.

To invoke the log window, select Show log on the toolbar or from the Tools menu.

The log browsing window contains two panels: the left one features the log list, while the right one shows selected log contents.
The left panel can contain up to 50 logs. If there are more, you can browse the list using the More and Less buttons with the left and right arrows.

To delete a log, select it and click Delete.

If any step was terminated by an error, the corresponding log will be marked with a red circle with a white cross inside.

The right window features the list of steps contained in the selected log. You can set up list parameters to display only messages of particular type, particular columns or select sorting order.

To sort messages by a particular column, click its header (click again to reverse order) or the Arrange Icons by button (the second from the right) and select the desired column.

To select columns to display, right-click the headers line or left-click the Choose Details button.

The three buttons to the left control message filters: the white cross in the red circle filters error messages, the exclamation sign in a yellow triangle filters warnings, and the “i” in the blue circle filters information messages.

You can also change column width by dragging the borders with a mouse.
Chapter 11. Troubleshooting

11.1 Recovering Acronis True Image

If Acronis True Image ceases running or produces errors, its files might be corrupted. To fix it, you will have to recover the program. To do this, run the installer again. It will detect Acronis True Image on your PC and will ask you if you want to recover (update) or remove it.

Click Recover and click Proceed.

11.2 Frequently asked questions

How do I use Acronis True Image on a Linux-based PC?

Acronis True Image supports the most popular Linux file systems, including Ext2, Ext3 and ReiserFS.

Acronis True Image can be run from a special bootable diskette or CD independently of operating system installed.

Having been run this way, it allows you to perform any disk (partition) image creation or restoration operations on a Linux-based PC.

What storage devices does Acronis True Image support for keeping backups?

Partition backups can be created on hard disks, and other storage devices supported by Windows 95/98/Me/NT 4/ 2000/XP.

What is the purpose of specifying image file size?

The PC hard disk is the fastest and most effective storage device. It can write a disk (partition) image considerably faster than any other device, such as a CD-R(W). Having specified image volume size equal to 600–650Mb, you can quickly create image files on your hard disk that you can burn to CD-R(W) media afterwards. This allows you to do the entire task much more quickly.

What devices can a system partition be restored from if Acronis True Image is loaded from its bootable diskette or CD?

Acronis True Image supports any connected hard disks as well as a wide variety of IDE, SCSI, FireWire (IEEE-1394), USB (1.0, 1.1, 2.0) and PC card (PCMCIA) interfaces and devices, including CD-ROM, CD-R(W), magneto-optical drives, Iomega Zip and Jaz.
Can Easy CD Creator 4.x–5.0 impede Acronis True Image?

Easy CD Creator 4.x and 5.0 automatically installs an old version of Take Two® backup utility that is no longer supported by its manufacturer, Roxio. If Acronis True Image 7.0 detects this utility, it shows you the following message in the beginning of image creation:

"Can’t create the image of the logical disk, as it’s already used by a running application. Please close all other applications and try again."

We recommend that you update your Easy CD Creator to Version 5.1 or newer and/or completely remove Take Two®.

For more information, visit http://www.roxio.com/en/support/roxio_support/taketwo.html

Is Acronis True Image 7.0 compatible with Roxio GoBack?

Yes, Acronis True Image 7.0 is compatible with Roxio GoBack under Windows. If you want to load Acronis True Image 7.0 from its bootable media, you will have to disable Roxio GoBack first.

Note that Roxio GoBack will be deleted from your hard disk during the restoration.

I created an image on CD-R(W) disks, but when I try to browse it, Acronis True Image tells me it can’t connect this image as a virtual disk.

The current version of Acronis True Image can connect images only if their files are located in the same place. If your image is located on several CD-R(W) or hard disks, you will have to copy all its files to a single folder on your hard disk.

If it is an incremental image, you will need all of the previous images up to the initial complete image.

I ran Acronis True Image from a bootable disk to restore a partition (disk) from an image located on the network drive, but couldn’t find the necessary PC.

If there’s at least one PC shown in the Network Neighborhood, try to access the required PC by typing its address in the file-name line like \computer\folder.

If there’s no network icon in My Computer, it means that either there are network problems or that Acronis True Image is trying to use the wrong drivers. Contact our technical support team (support@acronis.com) and provide all network adapter specifications and the network adapter manufacturer’s name.

I ran Acronis True Image from a bootable disk to restore a partition (disk) from an image located on the network drive, but it just kept asking me for username and password. What should I do?
In some cases, especially when there’s a domain controller installed in the network, you have to specify server or domain name before username. You must enter a username like SERVER\USER or DOMAIN\USER.

I received the "Can’t create image of disk D:, because it’s already used by applications or contains bad sectors" error message, where D: stands for my logical disk, when I tried to create an image under Windows.

Your logical disk might contain bad sectors. We recommend that you run a complete disk surface test. Under Windows 95/98/Me, run scandisk and perform the complete disk check. Under Windows NT/2000/XP, type “chkdsk /R D:” in the command line and reboot.

How can I prepare Windows XP, NT or 2000 for cloning or transferring to a PC with different hardware?

Before you clone or transfer Windows to another PC, you must prepare it with the Microsoft System Preparation Tool (sysprep). The reasons to do this are described in article 298491 in the Microsoft Knowledge Base: "One problem from duplicating an installation of Windows 2000 is that each cloned computer has the same security identifier (SID) and computer name. This may prevent the cloned computers from functioning correctly in a workgroup or a domain. To work around this problem, administrators use the System Preparation Tool (Sysprep.exe) to remove configuration settings that are unique to the computer, such as the computer name and SID." This problem also relates to Windows NT 4.0 and Windows XP, so you should prepare these OS in a similar way.

You can download Microsoft System Preparation Tool from www.microsoft.com or extract from deploy.cab located on Windows XP installation CD.

Below are brief instructions on how to prepare your hard disk for cloning or transferring to another PC:

1. Create bootable media using the corresponding wizard in the Acronis True Image menu.
2. Run sysprep.exe. You can specify the following as command line parameters:
   -nosidgen — if you plan to delete all data from the old disk and/or don’t plan to use the old and new disks in different PCs simultaneously
   -mini — if you plan to transfer your OS to a PC with different hardware
3. Insert the Acronis True Image bootable disk into the drive and load the program to create an image of the prepared disk.
4. Install the new disk in your PC or provide image access from the new PC.
5. Boot from the bootable disk again and restore the image to the new disk or PC.
6. Reboot.
We recommend that you read Microsoft’s sysprep articles available in relation to Windows NT 4.0/2000/XP.

**How can I burn Acronis True Image images to DVD disks?**

Acronis True Image can burn images to DVD disks under Windows if you have DVD UDF recording software installed. The DVD disk must be formatted. Currently, the program supports at least the following DVD recording software:

- Roxio DirectCD — optional component of Roxio Easy CD Creator
- Ahead InCD — available on the Nero Web site freely for Ahead Nero Burning Rom users (usually bundled with Nero)
- Veritas DLA and all its OEM versions (e.g. HP DLA)
- Pinnacle InstantCD/DVD

In general, the program also supports all other DVD UDF burst recording software, but the aforementioned applications were tested by Acronis for compatibility with Acronis True Image.

To enable image recording to DVD in Acronis True Image, you should do the following:

- Install DVD UDF recording software.
- Format DVD disks. DVD+RW and DVD-RW disks can be formatted in any of the aforementioned applications, while DVD-R and DVD+R formatting is currently supported by Roxio DirectCD only.
- Run Acronis True Image, insert a formatted DVD disk into your DVD+RW or DVD-RW drive and create an image. No other special actions are required.

Images stored on DVD disks can be restored under Windows and when Acronis True Image is loaded from its boot disk.

There is another way to burn an image to a DVD disk. Using Acronis True Image, you can create an image on your hard disk and burn it using the installed DVD recording application to a DVD disk afterwards. You will be able to restore images from such disks under Windows and when Acronis True Image is loaded from the bootable media.

### 11.3 Technical support

Users of legally purchased copies of Acronis True Image are entitled to free e-mail technical support from Acronis. If you have installation or working problems that you can’t solve by yourself using this manual and the readme.txt file, e-mail the technical support team.
Before you do this, you will have to register your copy at
http://www.acronis.com/registration/ or by mail.

When e-mailing technical support, you must provide the number of your Acronis
True Image copy that is written on a registration card bundled with the program.
This number is made up of five sets of five characters separated by hyphens; there
is a total of 25 letters and numbers.

For more information visit http://www.acronis.com/support/
Technical support e-mail address: support@acronis.com.
Appendix A. Partitions and file systems

A.1 Hard disk partitions

The mechanism that allows you to install several operating systems on a single PC or to carve up a single physical disk drive into multiple “logical” disk drives is called partitioning.

Partitioning is performed by special applications. In MS-DOS and Windows, these are FDISK and Disk Administrator.

Partitioning programs perform the following:

- create a primary partition
- create an extended partition that can be split into several logical disks
- set an active partition (applied to a single primary partition only)

Information about partitions on a hard disk is stored in a special disk area — in the 1st sector of cylinder 0, header 0, which is called the partition table. This sector is called the master boot record, or MBR.

A physical hard disk might contain up to 4 partitions. This limit is forced by the partition table that is suitable for 4 strings only. However, this does not mean you can have only 4 operating systems on your PC! Actually, existing applications called disk managers support far more operating systems on disks. For example, Acronis OS Selector enables you to install up to 100 operating systems!

A.2 File systems

An operating system gives the user the ability to work with data by supporting some type of file system on a partition.

All file systems are made of structures that are necessary to store and manage data. These structures are usually composed of operating system boot sectors, folders and files. File systems perform the following basic functions:

- track occupied and free disk space (and bad sectors, if any)
- support folders and file names
- track physical location of files on disks

Different operating systems use different file systems. Some operating systems are able to work with only one file system while others can use several of them. Here are some of the most widely used file systems.
A.2.1 FAT16

The FAT16 file system is widely used by DOS (DR-DOS, MS-DOS, PC-DOS, PTS-DOS and other), Windows 95/98/Me, and Windows NT/2000/XP operating systems and is supported by most other systems.

Main features of FAT16 are the file allocation table (FAT) and clusters. FAT is the core of the file system. To increase data safety, it is possible to have several copies of the FAT (there are usually two of them) on a single disk. A cluster is a minimum data storage unit in FAT16 file system. One cluster contains a fixed number of sectors. FAT stores information about what clusters are free, what clusters are bad, and also defines in which clusters files are stored.

The FAT16 file system has a 2GB limit that permits a maximum 65,507 clusters that are 32Kb in size. (Windows NT/2000/XP support partitions up to 4GB with up to 64Kb clusters). Usually the smallest cluster size is used to make the total cluster amount within the 65,507 range. The larger a partition is, the larger its clusters are.

Usually the larger the cluster size, the more disk space is wasted. A single byte of data could use up one cluster, whether the cluster size is 32Kb or 64Kb.

Like many other file systems, the FAT16 file system has a root folder. Unlike others, however, its root folder is stored in a special place and is limited in size (standard formatting produces a 512-item root folder).

Initially, FAT16 had limitations on file names. They could only be eight characters long, plus a dot, plus three characters of name extension. However, long-name support in Windows 95 and Windows NT bypasses this limitation. The OS/2 operating system also supports long names, but does so in a different way.

A.2.2 FAT32

The FAT32 file system was introduced in Windows 95 OSR2. It is also supported by Windows 98/Me/2000/XP. FAT32 is an evolved version of FAT16. Its main differences from FAT16 are 28-bit cluster numbers and a more flexible root, whose size is unlimited. The reasons FAT32 appeared are the support of large hard disks (over 8GB in capacity) and the impossibility to implement any more complex file system into MS-DOS, which is still the base for Windows 95/98/Me.

The maximum FAT32 disk size is 2 terabytes (1 terabyte, or TB, is equal to 1024 gigabytes, or GB).

A.2.3 NTFS

NTFS is the main file system for Windows NT/2000/XP. Its structure is closed, so no other operating system is fully supported. The main structure of NTFS is the MFT (master file table). NTFS stores a copy of the critical part of the MFT to reduce the possibility of data damage and loss. All other NTFS data structures are special files. NTFS stands for NT File System.
Like FAT, NTFS uses clusters to store files, but cluster size does not depend on partition size. NTFS is a 64-bit file system. It uses unicode to store file names. It is also a journaling (failure-protected) file system, and supports compression and encryption.

Files in folders are indexed to speed up file search.

A.2.4 Linux Ext2

Ext2 is one of the main file systems for the Linux operating system. Ext2 is a 32-bit system. Its maximum size is 16TB. The main data structure that describes a file is an i-node. A place to store the table of all i-nodes has to be allocated in advance (during formatting).

A.2.5 Linux Ext3

Officially introduced with its version 7.2 of the Linux operating system, Ext3 is the Red Hat Linux journaling file system. It is forward and backward compatible with Linux ext2. It has multiple journaling modes and broad cross-platform compatibility in both 32- and 64-bit architectures.

A.2.6 Linux ReiserFS

ReiserFS was officially introduced to Linux in 2001. ReiserFS overcomes many Ext2 disadvantages. It is a 64-bit journaling file system that dynamically allocates space for data substructures.
Appendix B. Hard disks and BIOS setup

The appendices below provide you with extra information on the hard disk organization, how information is stored on disks, how disks should be installed in the computer and plugged into the motherboard, configuring disks with BIOS, partitions and file systems, and how operating systems interact with disks.

B.1 Installing hard disks in computers

B.1.1 Installing a hard disk, general scheme

To install a new IDE hard disk, you should do the following (we will assume you have powered OFF your PC before you start!):

1. Configure the new hard disk as slave by properly installing jumpers on the board of its controller. Disk drives generally have a picture on the drive that shows the correct jumper settings.

2. Open your computer and insert the new hard disk into a 3.5” or 5.25” slot with special holders. Fasten down the disk with screws.

3. Plug the power cable into the hard disk (four-threaded: two black, yellow and red; there is only one way you can plug in this cable).

4. Plug the 40- or 80-thread flat data cable into sockets on the hard disk and on the motherboard (plugging rules are described below). The disk drive will have a designation on the connector or next to it that identifies Pin 1. The cable will have one red wire on an end that is designated for Pin 1. Make sure that you place the cable in the connector correctly. Many cables also are “keyed” so that they can only go in one way.

5. Turn your computer on and enter BIOS setup by pressing the keys that are displayed on the screen while the computer is booting.

6. Configure the installed hard disk by setting the parameters type, cylinder, heads, sectors and mode (or translation mode; these parameters are written on the hard disk case) or by using the IDE autodetection BIOS utility to configure the disk automatically.

7. Set the boot sequence to A:, C:, CD-ROM or some other, depending on where your copy of Acronis True Image is located. If you have a boot diskette, set the diskette to be first; if it is on a CD, make the boot sequence start with CD-ROM.

8. Quit BIOS setup and save changes. Acronis True Image will automatically start after reboot.

9. Use Acronis True Image to configure hard disks by answering the wizard’s questions.

10. After finishing the work, turn off the computer, set the jumper on the disk to the master position if you want to make the disk bootable (or leave it in slave position if the disk is installed as additional data storage).
B.1.2 Motherboard sockets, IDE cable, power cable

There are two slots on the motherboard to which the hard disks can be connected: primary IDE and secondary IDE.

Hard disks with an IDE (Integrated Drive Electronics) interface are connected to the motherboard via a 40- or 80-thread flat marked cable: one of the threads of the cable is red.

Two IDE hard disks can be connected to each of the sockets, i.e. there can be up to 4 hard disks of this type installed in the PC. (There are three plugs on each IDE cable: 2 for hard disks and 1 for the motherboard socket.)

As noted, IDE cable plugs are usually designed so that there is only one way to connect them to the sockets. Usually, one of the pinholes is filled on the cable plug, and one of the pins facing the filled hole is removed from the motherboard socket, so it becomes impossible to plug the cable in the wrong way.

In other cases, there is a jut on the plug on the cable, and an indentation in the socket of the hard disk and of the motherboard. This also ensures that there only one way to connect the hard disk and the motherboard.

In the past, this design of plug did not exist, so there was an empirical rule: the IDE cable is connected to the hard disk socket so that the marked thread is the closest to the power cable, i.e. the marked thread connected to pin #1 of the socket. A similar rule was used for connecting cables with the motherboard.

Incorrect connection of the cable with either the hard disk or the motherboard does not necessarily damage the electronics of the disk or the motherboard. The hard disk is simply not detected or initialized by BIOS.

There are some models of hard disks, especially the older ones, for which incorrect connection damaged the electronics of the drive.

We will not describe all the types of hard disks. Currently the most widespread are those with IDE or SCSI interfaces. Unlike IDE hard disks, there can be from six to 14 SCSI hard disks installed in your PC. However, you need a special SCSI controller (called a host adapter) to connect them. SCSI hard disks are not usually used in personal computers (workstations), but are found mostly in servers.

Aside from an IDE cable, a 4-thread power cable must be connected to the hard disks. There is only one way to plug in this cable.

B.1.3 Installation modes, jumpers

1. A hard disk can be installed in a computer as master or as slave. The mode of hard disk installation is defined by the position of special connectors (called jumpers) on the hard disk.

The jumpers are either located on the electronic board of the hard disk or a special socket that provides for the connection of the hard disk and the motherboard.
There is usually a sticker on the drive that explains the markings. Typical markings are DS, SP, CS and PK.

Each jumper position corresponds to one hard disk(s) installation mode:

- **DS** – master/factory default
- **SP** – slave (or no jumper required)
- **CS** – cable select for master/slave: the purpose of the hard disk is determined by its physical position with respect to the motherboard
- **PK** – jumper parking position: the position where one can put the jumper if it is not necessary in the existing configuration

The hard disk with the jumper in master position is treated by the basic input/output system (BIOS) as bootable.

The jumpers on hard disks that are connected to the same cable can be in the cable select for master/slave position. In this case, BIOS will deem as «master» the disk that is connected to the IDE cable closer to the motherboard than the other one.

Unfortunately, hard disk markings were never standardized. You might well find that markings on your hard disk differ from the ones described above. Moreover, for the old types of hard disks, their purpose could be defined by two jumpers instead of one. You should study the markings carefully before installing your hard disk in the computer.

It is not enough to physically connect the hard disk to the motherboard and set the jumpers properly for the hard disk to function — hard disks have to be properly configured with the motherboard BIOS.
B.2 BIOS

When you turn on your computer, you often see a number of short text messages before you see the splash screen of your operating system. These messages are from the POST (power-on self test) program that belongs to BIOS and is executed by the processor.

BIOS, or the basic input/output system, is a program that resides in the permanent memory chip (ROM or flash BIOS) on the motherboard of your computer and is its key element. The version of BIOS that you use «knows» all the peculiarities of all the components of the motherboard: processor, memory, integrated devices. BIOS versions are provided by the manufacturers of motherboards.

Main BIOS functions are:

- POST checking of processor, memory and I/O devices
- initial configuring of all software-manageable parts of the motherboard
- initialization of operating system (OS) booting process

Among numerous components of the computer, initial configuring is necessary for the external memory subsystem that controls hard disk drives, floppy disk drives, CD-ROM drives, DVDs and other devices.

B.2.1 Setup utility

BIOS has a built-in setup utility for initial computer configuring. To enter it, you have to press a certain combination of keys (Del, F1, CTRL+ALT+Esc, CTRL+Esc, or some other, depending on your BIOS) during the POST sequence that starts right after you turn your computer on. Usually the message with the required combination of keys is displayed during the startup testing. Pressing this combination takes you to the menu of the setup utility that is included in your BIOS.

The menu can differ in appearance and sets of items and their names, depending on the BIOS manufacturer. The most widely known BIOS makers for PC motherboards are Award/Phoenix and AMI. Moreover, while items in the standard setup menu are mostly the same for various BIOSes, items of the extended setup heavily depend on computer and BIOS version.

Below we describe the general principles of initial hard disk configuring, and then configuring (sample) in AwardBIOS.

Large PC manufacturers like Dell and Hewlett-Packard produce motherboards themselves, and develop their own BIOS versions. You should always refer to the documentation that came with your computer for instructions on proper BIOS configuring.

B.2.2 Standard CMOS setup menu

Parameters in the standard CMOS setup menu usually define the geometry of the hard disk. The following parameters (and values) are available for each hard disk installed in your PC:
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>1-47, Not Installed, Auto</td>
<td>Type 0 or Not Installed is used when there is no hard disk installed (to uninstall it). Type 47 is reserved for user-defined parameters or for parameters detected by the IDE Auto detection utility.</td>
</tr>
<tr>
<td>Auto value</td>
<td>Auto value allows for automatic detection of IDE disk parameters during the boot sequence.</td>
<td></td>
</tr>
<tr>
<td>Cylinder (Cyl)</td>
<td>1-65535</td>
<td>The number of cylinders on a hard disk. For IDE disks, a logical number of cylinders is specified.</td>
</tr>
<tr>
<td>Heads (Hd)</td>
<td>1-16</td>
<td>The number of heads on a hard disk. For IDE disks, a logical number of heads is specified.</td>
</tr>
<tr>
<td>Sectors (Sec)</td>
<td>1-63</td>
<td>The number of sectors per track of a hard disk. For IDE disks, a logical number of sectors is specified.</td>
</tr>
<tr>
<td>Size (Capacity)</td>
<td>MBytes</td>
<td>The capacity of the disk in megabytes. It is calculated according to the following formula: Size=(Cyl x Hds x Sct x 512) / 1024 / 1024.</td>
</tr>
<tr>
<td>Mode (Translation Method)</td>
<td>Normal/LBA/Large/Auto</td>
<td>Method of translation of sector addresses.</td>
</tr>
</tbody>
</table>
For example, to demonstrate the main features of Acronis True Image we used a Quantum<sup>TM</sup> Fireball<sup>TM</sup> TM1700A hard disk as one of the disks in our examples. Its parameters have the following values:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Auto</td>
</tr>
<tr>
<td>Cylinder (Cyl)</td>
<td>827</td>
</tr>
<tr>
<td>Heads (Hd)</td>
<td>64</td>
</tr>
<tr>
<td>Sectors (Sec)</td>
<td>63</td>
</tr>
<tr>
<td>Mode</td>
<td>Auto</td>
</tr>
<tr>
<td>CHS</td>
<td>1707 MB</td>
</tr>
<tr>
<td>Maximum LBA Capacity</td>
<td>1707 MB</td>
</tr>
</tbody>
</table>

In BIOS setup, you can set the Type parameter to User Type HDD (user-defined type). In this case, you also have to specify the value of the translation mode parameter, which can be Auto/Normal/LBA/Large.

Translation mode is how sector addresses are translated. This parameter appeared because in BIOS versions, there were limitations to the maximum address capacity of disks, which is 504 MB (1024 cylinders x 16 heads x 63 sectors x 512 bytes). There are two ways to bypass this limitation: (1) switch from physical to logical sector addresses (LBA), (2) use mathematics to reduce the number of addressed sectors (cylinders) and increase the number of heads; this method is called Large Disk (Large). The simplest decision is to set the value of this parameter to Auto.

If there are several hard disks connected to your motherboard, but you do not want to use some of them at the moment, you have to set the Type of these disks to Not Installed.

Parameters of hard disks can be set manually with the help of information provided by the hard disk manufacturer on its case, but it is easier to use the IDE autodetection utility that is usually included in modern BIOS versions.

The utility is sometimes a separate BIOS menu item and sometimes is included in the standard CMOS setup menu.

Please note that in Appendix B. «Hard disks and BIOS setup» we have described the general details of physical hard disk structure. Built-in IDE hard disk controls mask the physical disk structure. As a result, the BIOS of the motherboard «sees» logical cylinders, heads and sectors. We are not going to elaborate on this issue here, but knowing about this can sometimes be useful.

**B.2.3 Arranging boot sequence, advanced CMOS setup menu**

Aside from standard CMOS setup, BIOS menu usually has an advanced CMOS setup item. Here you can adjust the boot sequence: C:; A:; CD-ROM:.
Please note that **boot sequence** management differs for various BIOS versions, e.g. for AMI BIOS, AWARDBIOS and brand-name hardware manufacturers.

Several years ago, the operating system boot sequence was hard-coded into the BIOS. An operating system could be booted either from a diskette (drive A:), or from the hard disk C:. That was the sequence in which the BIOS queried external drives: if drive A: was ready, BIOS attempted to boot an operating system from a diskette. If the drive was not ready or there was no system area on diskette, BIOS tried to boot an operating system from hard disk C:.

At present, BIOS allows booting operating systems not only from diskettes or hard disks, but also from CD-ROMs, DVDs and other devices. If there are several hard disks installed in your computer labeled as C:, D:, E:, and F:, you can adjust the boot sequence so that an operating system is booted from, for example, disk E:. In this case, you have to set the boot sequence to look like E:, CD-ROM:, A:, C:, D:.

This does not mean that booting is done from the first disk in this list; it only means that the **first attempt** to boot an operating system is to boot it from this disk. There may be no operating system on disk E:, or it can be inactive. In this case, BIOS queries the next drive in the list. Errors can happen during the booting, see B.2.5 «Hard disk initialization errors».

The BIOS numbers disks according to the order in which they are connected to IDE controllers (primary master, primary slave, secondary master, secondary slave); next go the SCSI hard disks.

This order is broken if you change the boot sequence in BIOS setup. If, for example, you specify that booting has to be done from hard disk E:, numbering starts with the hard disk that would be the third in usual circumstances (it is usually the secondary master).

After you have installed the hard disk in your computer and have configured it in BIOS, one can say that the PC (or the motherboard) «knows» about its existence and its main parameters. However, it is still not enough for an operating system to work with the hard disk.
Below, we provide an example of configuring hard disks in AwardBIOS.

The **Main** AwardBIOS menu, which is responsible for configuring hard disks on motherboards for Celeron, Pentium II-III and AMD-K6/K7 processors usually looks like this:

```
AwardBIOS Setup Utility

<table>
<thead>
<tr>
<th>Main</th>
<th>Advanced</th>
<th>Power</th>
<th>Boot</th>
<th>Exit</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Time</td>
<td>[16:16:35]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>System Date</td>
<td>[01/10/2001]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Legacy Diskette A</td>
<td>[1.44M, 3.5in]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Legacy Diskette B</td>
<td>[None]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Floppy 3 Mode Support</td>
<td>[Disabled]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Primary Master</td>
<td>[Auto]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Primary Slave</td>
<td>[Auto]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Secondary Master</td>
<td>[Auto]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Secondary Slave</td>
<td>[Auto]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Language</td>
<td>[English]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supervisor Password</td>
<td>[Disabled]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>User Password</td>
<td>[Disabled]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Halt On</td>
<td>[All but Disk/Keyboard]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Installed Memory</td>
<td>[Disabled]</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Item Specific Help:

<Enter> to go to sub-menu.
Place the marker on the Primary Master line and press the **Enter** key to get to the screen that looks like this:

---

**AwardBIOS Setup Utility**

<table>
<thead>
<tr>
<th>Main</th>
<th>Item Specific Help:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary Master [Auto]</td>
<td>&lt;Enter&gt; to select the type of the IDE drive.</td>
</tr>
<tr>
<td>Type [Auto]</td>
<td>[User Type HDD] allows you to set each entry on your own.</td>
</tr>
<tr>
<td></td>
<td>Warning: Ultra DMA Mode 3/4/5 can be enabled only when BIOS detects Shielded 80-pin cable.</td>
</tr>
</tbody>
</table>

---

F1 Help ↓ Select Item +/- Change Values F5 Setup Defaults
Esc Exit ←→ Select Menu Enter Select Sub-Menu F10 Save and Exit

---

Place the marker on the value of the Type parameter ([Auto] in this case) and press the **Enter** key to open the list of possible values of this parameter; for example:

- None
- Auto
- User Type HDD
- CD-ROM
- LS-120
- ZIP-100
- MO
- Other ATAPI Device
Use the **Up** and **Down** keys to select the User Type HDD value and press the **Enter** key to get to the following screen:

![AwardBIOS Setup Utility](image)

<table>
<thead>
<tr>
<th>Main</th>
<th>Item Specific Help:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>[User Type HDD] &lt;Enter&gt; to select the type of the IDE drive.</td>
</tr>
<tr>
<td>Translation Mode</td>
<td>[LBA]</td>
</tr>
<tr>
<td>Cylinders</td>
<td>[………0] [User Type HDD] allows you to set each entry on your own.</td>
</tr>
<tr>
<td>Head</td>
<td>[……0]</td>
</tr>
<tr>
<td>Sector</td>
<td>[...0]</td>
</tr>
<tr>
<td>CHS Capacity</td>
<td>0MB</td>
</tr>
<tr>
<td>Maximum LBA Capacity</td>
<td>0MB</td>
</tr>
<tr>
<td>Multi Sector Transfer</td>
<td>[Maximum] Warning: Ultra DMA Mode 3/4/5 can be enabled only when BIOS detects Shielded 80-pin cable.</td>
</tr>
<tr>
<td>SMART Monitoring</td>
<td>[Disabled]</td>
</tr>
<tr>
<td>PIO Mode</td>
<td>[4]</td>
</tr>
<tr>
<td>Ultra DMA Mode</td>
<td>[5]</td>
</tr>
</tbody>
</table>

Enter the values of Translation Mode, Cylinders, Head and Sector parameters (you can find them on the case of the hard disk) to finish the initial configuring of the hard disk with BIOS.

Translation Mode parameter can have the following values:

- LBA
- Large
- Normal
- Match Partition Table
- Manual
New versions of AwardBIOS menu have the **Boot** item. The screen of the **Boot** menu, which is responsible for adjusting the boot sequence, looks like this:

<table>
<thead>
<tr>
<th>Main</th>
<th>Advanced</th>
<th>Power</th>
<th>Boot</th>
<th>Exit</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. ATAPI CD-ROM</td>
<td>[None]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2. Removable Device</td>
<td>[Legacy Floppy]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3. IDE Hard Drive</td>
<td>[IBM-DTLA-307020]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4. Other Boot Drive</td>
<td>[Disabled]</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Plug & Play O/S [No]
Boot Virus Detection [Enabled]
Quick Power On Self Test [Enabled]
Boot up Floppy Seek [Enabled]
Full Screen Logo [Enabled]

Boot Sequence:
<Enter> to select the device, use up or down arrow.
Press <--> to move the Device up the list, or,<--> to move it down the list

Place the marker on the field to the right of the 3. IDE Hard Drive item and press the **Enter** key to open the list of all hard disks connected to your computer and detected by BIOS, together with the Disabled line; for example:

```
Disabled
Quantum FireBALL_1700A
IBM DTLA-307020
Quantum FireBALL_1700A
```

This device sequence in the upper left corner of the screen means that when looking for a boot disk, the BIOS will first query the CD-ROM (1. ATAPI CD-ROM), but there is no CD-ROM in the current configuration. Next it queries the floppy disk drive (2. Removable Device). Only if none of these disks contains an operating system, does BIOS query the hard disk (3. IDE Hard Drive) that has been selected from the list.
Select an item of the list with the **Up** or **Down** keys and move the device up the list or down it with help of + or - keys. This will change the boot sequence. For example, you can select the boot sequence as the one shown below:

<table>
<thead>
<tr>
<th>Main</th>
<th>Advanced</th>
<th>Power</th>
<th>Boot</th>
<th>Exit</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Removable Device</td>
<td>[Legacy Floppy]</td>
<td></td>
<td>Boot Sequence:</td>
<td></td>
</tr>
<tr>
<td>2. ATAPI CD-ROM</td>
<td>[None]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3. IDE Hard Drive</td>
<td>[IBM-DTLA-307020]</td>
<td>&lt;Enter&gt; to select the device To select the boot sequence, use up or down Arrow.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4. Other Boot Drive</td>
<td>[Disabled]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plug &amp; Play O/S</td>
<td>[No]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Boot Virus Detection</td>
<td>[Enabled]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quick Power On Self Test</td>
<td>[Enabled]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Boot up Floppy Seek</td>
<td>[Enabled]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Full Screen Logo</td>
<td>[Enabled]</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

F1  Help  ↓  Select Item  +/-  Change Values  F5  Setup Defaults
Esc Exit  ←→  Select Menu  Enter  Select Sub-Menu  F10  Save and Exit

After setting the specified parameters, use the **Left** or **Right** keys to select the **Exit** menu item. Reply positively to the prompt on saving the specified parameters.

For AwardBIOS for motherboards for Pentium, Pentium Pro processors (i.e the ones older than those described above) and AMD-K5/K6, the standard CMOS setup screen looks like this:
The Type parameter can have Auto, Not Installed or User Defined values. In the latter case, you have to specify the values of other parameters manually (except MODE) according to the information on the case of the hard disk.

The purpose of the MODE and LANDZ parameters is described in the note above. The PRECOMP parameter is the so-called precompensation parameter and is important only for the older hard disks (MFM and RLL). IDE disks ignore this parameter.

In earlier BIOS versions, the boot sequence was set in the BIOS FEATURES setup section in the Boot Sequence line where you could select the most typical boot sequences, for example C:; A:; CD-ROM: or CD-ROM:; C:; A:, and other.

### B.2.5 Hard disk initialization errors

Devices are usually initialized successfully, but sometimes errors can happen. Typical errors related to hard disks are reported by the following messages:

**PRESS A KEY TO REBOOT**

This error message is not directly related to errors during hard disk initialization. However, it appears, for example, when the boot program finds no operating system on the hard disk, or when the primary partition of the hard disk is not set as active.

**DISK BOOT FAILURE,**
**INSERT SYSTEM DISK AND**
**PRESS ENTER**

This message appears when the boot program finds no available boot device, be that a floppy or a hard disk, or a CD-ROM.

**C: DRIVE ERROR**
**C: DRIVE FAILURE**
ERROR ENCOUNTERED
INITIALIZATION HARD DRIVE

This message appears when it is impossible to access the C: disk. If the disk is known to be functional, the reason for this error message is probably incorrect settings/connections of:

- hard disk parameters in BIOS setup
- jumpers on the controller (master/slave)
- interface cables

It is also possible that the device is out of order, or the hard disk is not formatted.